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Contents of this tutorial:

—_—

Extracting data from open sources

2. Using ArcGIS Pro’s analytical tools to create walkable
catchment buffers

Creating final layout

Exporting

W

e Layers Used:

e NZ Facilities: Koordinates
https://koordinates.com/from/data.linz.qgovt.nz/layer/105588-nz-facilities/

e Bus Stops: Auckland Transport Open GIS Data
https://data-atgis.opendata.arcqgis.com/datasets/ATqgis::bus-stop/explore
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https://koordinates.com/from/data.linz.govt.nz/layer/105588-nz-facilities/
https://data-atgis.opendata.arcgis.com/datasets/ATgis::bus-stop/explore

ArcGIS Pro User Interface
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ArcGIS Pro: Create a Project

» Create a new project and give it an appropriate name.

* It should automatically save into Documents > ArcGIS > Projects > (project name)

New Project
AT = This PC » JDocuments » ArcGIS » Projects » Tutorial
B @ [ A ' ,\ '
. — Mame Date medified Type Size
Map Catalog Global Scene Local Scene Start without a template
ImportLog 2310:15 pm File folder
Index 2310:15 pm File folder
Tutorial.gdb 2310:15 pm File folder
=1 Tutorial 23 10:15 pm ArcGIS Project File TKB
|| Tutorial.athx 2023 10:15 pm ATBX File 1KB
Create a New Project X
[ Mame [ Tutora | | This folder will be your main folder to move downloaded
Location | CAUsers' Documents\ArcGIS\Projects | 3 CO nte nt IntO
[/ Create a new folder for this project
If you wish to save the project, make sure to copy the
entire folder onto your OneDrive/USB when you are

finished.
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Extracting Data from
Open Sources
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Begin by going to Koordinates or
using the link provided earlier,
find NZ Facilities layer

Use the zoom tool or search to
find the site in Westmere

Select Crop on the top right. And
crop to an extent you are happy
with showing on your map.

Select Shapefile and click create
export (make sure you are logged

Coordinate Reference System

into your Koordinates account RS pe—
otherwise you won’t be able to
export)

eative Commons Atfribution 4.0 International | License

Once the zip file is downloaded,
extract the files and put it into
your ArcGIS Pro Project file

W locnz-facilities-SHP.zip

ARk



@ Auckland Transport Open GIS Data

Download Options Records: Filtering 451 of 5,503 Point
BusS

Te A
Peri
n updated file may take
e Fre
stgere 5
: aften,
Te Atat e X
South i
)
. Grey B /]
Shapefile e . . Edeng el
File created: Jul 21,2023, 11:27 .
Fil 9KB
Pt a=oy &
CheVal . Newparkpt
Kingslafla )
GeoJSON
Rosebank
Ren
‘ n updated file may take Epgom
.
\ ARt

® Use the zoom tool or search to find the site in Westmere
® Select Draw an area on the right side. And crop to an extent you are happy with showing on your map.
® Make sure toggle filters is on, then find Download on the left side panel, and choose the Shapefile option

® Once the zip file is downloaded, extract the files and put it into your ArcGIS Pro Project file —~—



» ThisPC » Documents » ArcGIS » Projects » Walkable Catchment Tutorial »

.

Mame Status Date medified
: backups @ 21/07/2023 1:1
@ 21/07/2023 1:2
= GpMessages o 21/07/2023 1:2
s ImportLog = 21/07/2023 1:2
Index = 21/07/2023 1:2
-Thel = 21 2023 1:2
Walkable Catchment Tutorial.gdb = 21 2023 1:2

The Unive .
=1 Walkable Catchment Tutorial.aprx @ 21/07/2023 12
|| Walkable Catchment Tutarial.atbx @ 21/07/2023 11

X

Catalog v R

Project Portal Favorites

Search Project P v

o' Maps
Toolboxes

ol Databases

@ Styles
4 [ Folders
4 gy Walkable Catchment Tutorial
b P@ Walkable Catchment Tutorial.gdb
b backup
() BusServiceshp

b Importlog

el NZ Facilities
nz-facilities.shp

nz-facilities.txt
nz-facilities.xml
b fé Walkable Catchment Tutorial.atbx

b % Locators

e Your ArcGIS Pro Project file should be located in Documents > ArcGIS > Projects
e Once your files have been moved into your folder, it should look like this and in
ArcGIS’s catalogue panel you should be able to view them under folders

[if you cannot see catalog, View > Catalog Pane]
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ArcGIS Manipulation

I



Zoom into the site or Map > Locate >
Search: 182 Garnet Rd, Westmere

Then under catalog and drag each
and all of the layers we have exported

online from folders into your contents
[if you cannot see catalog, View > Catalog Pane]

CCR=E=] <
Project  Map  Insert  Analysis  View
aobal EY | P2 VA i
o @ | T < '
° Convert K Link Reset Catalog
ol Map Views~ C Panesv Pane
View Link
Contents * X
T ‘SEDF(;‘ o v

=0 K/ H{é E

Drawing Order
4 [E] Map
(] World Topographic Map
[v] World Hillshade

Catalog

Project Portal Favorites

| Search Project

Maps
Toolboxes
Databases

Styles

4 9 0 ® g

Do o o o

Folders
4 W Walkable Catchment Tutorial
b % Walkable Catchment Tutorial.gdb

b backups
4 Bus Services
I @ BusService.shp
b Importlog
el NZ Facilities

(B nz-facilities.shp
nz-facilities.txt
Drag over nzfacilities xml

b Eg Walkable Catchment Tutorial atbx

b # Locators
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Site Boundary

To create a site boundary...

Catalog v X

Project Portal Favorites =)
Search Project by V|

b | Maps

I @ Toolboxes

4 [gl Databases

b Fﬁh Walkable Catchment Tutorial.gdb
b iE Layouts
b lgd Styles
4 [5d Folders
4 vz, Walkable Catchment Tutorial
b F@ Walkable Catchment Tuterial.gdb I

b _backups
4 Bus Services
() BusService.shp
b Importlog
4 NZ Facilities

@& nz-facilities.shp

® Right click on the
database file (.gdb)

Catalog

Project Portal Favorites

ax

Search Project

5]

b i@ Maps
b i@ Toolboxes

Point Erin Park

=
P
2
& 4 [Gl Databases

[ Walkahle Catchment Tutorial gdb

New > 9 Feature Dataset

(@ Feature Class

i E3 Table
()
Add To Favorites o View b
=3 ialg
% Add To New Projects %5 Relationship Class
@B Raster Dataset
Import >
T Mosaic Dataset
Export >
~ & Toolbox
Manage
NZ Facilities
-
T Domains @ nz-facilities.shp
Distributed Geodatabase > B nz-facilities.txt
) ’
2 Refresh ¥ nz-facilities.xml
F3 Walkable Catchment Tutorial.atbx
B copy Ctrl+C

cators

® Create New > Feature Class

Create Feature Class v

Define
e e o 0 0 0

& X Create Feature Class v

Neme | Site_Boundary

Alias |

Feature Class Type

Type of features stored in the feature class.

IPongon I M

Geometric Properties

0 M Values - Coordinates include M values
— used to store route data.

0 Z Values - Coordinates include Z values
— used to store 3D data.

[v] Add output dataset to current map

®* Thentypein a
name, make sure
the type is Polygon
and uncheck Z
Values. Hit next on
the bottom panel

Spatial Reference
® e 00 00

Select the Coordinate System to view the available
options.

Current XY Details

NZGD 2000
New Zealand
Transverse
Mercator

XY Coordinate Systems Available

Pv‘?:“ &

‘ Search

Favorites

4 layers

4 ‘l‘i’f‘?ﬁ NZGD 2000 New Zealand Transverse

Page 3/6

Finish ‘ Cancel

| Previous H Next

® For Spatial Reference
select NZGD 2000 New
Zealand Transverse
Mercator and hit finish
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Site Boundary

Walkable Catchment Tutorial | @ Command Search (Alt+Q

VIEW Imagery Share Feature Layer Labeling Data
Topology - 1 4 [Fﬁ EZ Attributes I~
L W i H # ; u 0
= Snapping | Create Modify Delete | Select — Move Annotation Edit Reshape Merge
rInspector < @ Zoom To Vertices

its

B -4 B R

[E Snapping Features El Selection El Tools

split

Fl

3 [] SiteBoundary

|Iiii AODO%d

21

=
® To draw the site boundary, go under edit > create and
on your right you should see the panel Create

Features

Create Features

Y Search

Choose Site Templates Favorites
Boundary then select oy
the first option and 8 Bus Service
begin draWing v Schools
Schools

v SiteBoundary
[] SiteBoundary

Drawing Order

[E] Map

4[] Bus Service

C)

oundary

[ |

4[] Schools

| NZ Topagraphic

® Once you have your site boundary drawn
double click on the icon on the layer (on your
left side’s contents panel) to bring up
symbology and you can adjust appropriately
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Catalog v

Project Portal Favorites

0 x

Point on Site

To create a buffer we first need to create a point on site

Search Project

b | Maps
I @ Toolboxes
4 [gl Databases

b Fﬁh Walkable Catchment Tutorial.gdb
b iE Layouts
b lgd Styles
4 [5d Folders

4 vz, Walkable Catchment Tutorial
b F@ Walkable Catchment Tuterial.gdb I

b _backups
4 Bus Services
() BusService.shp
b Importlog
4 NZ Facilities

@& nz-facilities.shp

® Right click on the
database file (.gdb)

s
2
3
S
S

New

¥ | Catalog v X

Project Portal Favorites =

Search Project

5]

b i@ Maps
b i@ Toolboxes

PointErinPark’ | 4 f5i Databases

[ Walkahle Catchment Tutorial gdb

> @ Feature Dataset

(@ Feature Class

i E3 Table
()
Add To Favorites o View b
=3 ialg
% Add To New Projects %5 Relationship Class
@B Raster Dataset
Import >
T Mosaic Dataset
Export >
~ & Toolbox
Manage
NZ Facilities
-
T Domains @ nz-facilities.shp
Distributed Geodatabase > B nz-facilities.txt
) ’
2 Refresh ¥ nz-facilities.xml
F3 Walkable Catchment Tutorial.atbx
B copy Ctrl+C

cators

® Create New > Feature Class

Create Feature Class

Define
L I B )

Mame | Site_center

Alias |

Feature Class Type

Type of features stored in the feature class.

[Font 1-

Geometric Properties

0 M Values - Coordinates include M values
— used to store route data.

M Z Values - Coordinates include Z values
—  used to store 3D data.

|| Add output dataset to current map

®* Thentypein a
name, make sure
the type is Point and
uncheck Z Values.
Hit next on the
bottom panel

v B X Create Feature Class ~ 32X

Spatial Reference
® e 00 00

Select the Coordinate System to view the available
options.

Current XY Details

NZGD 2000
New Zealand
Transverse
Mercator

XY Coordinate Systems Available

Pv‘?:“ &

‘ Search

Favorites

4 layers

4 ‘l‘i’f‘?ﬁ NZGD 2000 New Zealand Transverse

Page 3/6

Finish ‘ Cancel

| Previous H Next

® For Spatial Reference
select NZGD 2000 New
Zealand Transverse
Mercator and hit finish
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VIEW Imagery Share

Topology - = 4 ['] B9 Atributes
+ | E e

= Snapping [|_Create [todify Delete | Select =%

r Inspector = ZoomTo

its [E Snapping Features El Selection Fl

Point on Site

P Command Search (Alt+Q

Walkable Catchment Tutorial

Feature Layer Labeling Data

Move Annotation Edit
Vertices

M~

Reshape Merge

Tools

Templates Favorites
~ Bus Service
) Bus Senvice
~ Schools
Schools

~ Site_center

split

Create Features
Y Search
Templates Favorites
¥ Bus Service

B Bus Service

v Schools
Schoals

v Site_center

® Site_center

v siteBoundary
[ siteBoundary

v SiteBoundary
[ siteBoundary

To draw the point on site,
go under edit > create and
on your right you should
see the panel Create
Features

Select Site Center and you
can select a point to place
down

® Then close to finish and edit symbology
from the contents panel (left) by double
clicking the icon to pull up symbology
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Layers under
contents can be
checked or
unchecked for
visibility.

Different order of the
layers also changes
the visibility.

Double click the title
of the layer to
rename it (NZ-
facilties can be
renamed to schools)

Double click on the
icon to open
symbology panel on
the right

Adjust the symbology
to whichever is
appropriate.

Contents

T | Search

=3/

Drawing Order

ADMEp

4 [v] Bus Service

=]

LS

[v| SiteBoundary

O

4 IZ| Schools

[v] NZ Tepographic

=

I x

Symbology - BusService v
® Format Point Symbol

Gallery Properties

[bus % ] [Astytes -

Symbols found: 60 (2

> 3D Street Scene

» 3D Transportation

> 3D Vegetation - Realistic
> 3D Vegetation - Thematic
v ArcGIS 2D

= & e

Bus Station Bus Station Bus Station

¥ Icon Points

=]

Bus

~ Intelligence

" # ¥ ¥

Workplace Workplace Manipulat... Manipulat.
r

Manipulat.

~ Primitives

=} = e

Bus Station Bus Station Bus Station

~ Pushpins

@ ¢ ¢

Bus Station Bus Station Bus Station

T

Under Gallery:
You are able to

find preset
icons and
images.

Search up bus
to find the bus
icon

Symbology - BusService
® Format Point Symbol

Gallery Properties

S S

Enable scale-based sizing

I x

100% | |7

Under Properties:
You are able to
change colors and
size
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Creating walkable

<

Project Map Insert Analysis View Edit Imagery
’I:D #9 ModelBuilder D z
. L Python v o 2
History Ready To Pairwise Summarize Spatia
%< Environments Use Tools Buffer Within Join
Geoprocessing 5] Tools

A~

Under Ana|y5IS Geoprocessing v X

> Tools, search (®) [ summerize nearty )

up Summarize
Nearby.

Summarize Nearby (“nz

Finds features that are within a specified distanc v
of features in the input layer and calculates stat.

To use this tool, you
will need to be signed
into your AcrGIS Pro
Account if you don’t
have one, please see
our website for
further instructions.

Summarize Attributes
Calculates summary stati

class.

0 +

or fields in a feature

Summarize Center And Dispersion (=

Finds central features and directional distributions
and calculates mean and median locations from t...

Neighborhood Summary Statistics 5oz

buffers

Geoprocessing v X Bl
® Summarize Nearby @
Share Feature Layer Lak B
This toel may consume ArcGIS credits.
] Eﬂ - Parameters Environments
Pairwise  Optimized Hot Input Features
Clip Spot Analysis | Site_center - A
The input has a selection. Records to be
processed: 1
Input Summary Features -
Site_center v s

The input has a selection. Records to be
processed: 1

Output Feature Class

Site_center_SummarizeNearby

Distance Measurement
Walking time

() Add anather

Then choose

your site center | R : | ‘
as the input and Time o Doy -
input summary Time Zone -

Geolocal -

| Keep polygons with no points

features and

choose your -
parameters as | Add shape summary attributes -
the following. '

Statistic

Group Field

Then hit “run”

minutes, and 15 minutes.

Once the analysis has been completed, your
screen should look similar to this.

Repeat the steps again to get a buffer for 10


https://www.drh.nz/2023/03/20/how-to-access-and-install-arcgis-pro-updated-2023/

Double click on the
layer text to rename
the layer

Double click the
icon to open up
symbology to
change colors

Customising walkable
buffers

o © o x R oo Elvint
¥ | search L

Under
symbology,

open color and

color

properties, and
you are able to

change the

transparency

(suggested
75%)

Gallef§ Properties

“

¥ Appearance
Color

outiif EINo color

AreGIS Calors
Outii

Angl¢

Color Editor

Color Mode

RGB

Symbology - Site_center_Summar... v %
© Format Polygon Symbol

x

=

To change the
style of the
outline follow:

Hit apply to see
the effect on
your map

Symbology - Site_center_Summar... v # X
® Format Polygon Symbal =
Gallery Properties
©
Vi - —— |Solidstroke - o
vl Solid fill g
~ Appearance
Color -
idth 1pt -

Dash template

At line ends

Offset clong line

> Caps & Join

> Output
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ArcGIS Exporting
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Once you are
happy with the
map create the
final export
through Insert
> New Layout
> choose your
template
(usually A3
Landscape)

Add your map
Insert > Map
Frame, you
may choose a
circle instead
of rectangle for
a circular map

Click and
drag to draw
your map.
Then change
the scale at the
bottom left.

1:10,000 M

B Eg@oyo-

bvl

Project Layout Insert Analysis View
b ﬁ = New Report ~ I,ﬂ Import Map -E.-j_'
= |, v B v —
Newd  New [F Mew MNotebook = Import Layout
Map LLayout J &5 Toolbox ~ @ Task v -
Project
Contents
T Search
Insert Analysis Wiew Imagery Share Help
eport v (] Import Map -ﬁ-i:] it I_—I ] Rectangle v
lotebook ~ 3 Import Layout v Cun":&inm Add Map Extent Indicator ¥
- &) Task ~ Folder [ Frame~| ~ i -
Project

AN

1:10.548

Default Extent

Imagery

[ 3

==

Connections  Add
Folder

Share

Map
Frame~

Help

i Rectang

Extent Ir

Grid ~

Series v

Map

Refresh Map Series

a% - |[F] - |

o
o) O)

o)

T

L)

En

Insert Analysis View Imagery Share Help Map Frame
_E’ 8| select A VDS 1 Size v Rulers D a ﬂl] ABC
v g — . = exa (B
Y| Navigete T 1) | guiegy [F] ClesrSelection | B Orientation Guides B p tivate < ¥ ZoomTo Bookmarks | Check
~ [0 pelete Layout~ [[5 Pagefrom Printer | |+ Margins |- -~ Map View~ ) Spelling
Mavigate Elements Page Setup ] Show Map Review ¥

® To move your base map around go into Layout > Activate

5 =
I‘G 051 8= wW A = A &
e i, [ AL | :
Morth  Scale Legend | Chart  Table Additional - - Dynamic
Arrow~ Barv - Frame~ Frame~ Surrounds e e ) o |3 Text~
Map Surrounds Graphics and Text [F]

® Don't forget your mapping conventions:
- Title

- Scale

- Legend

- North Arrow

- Date
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Drawing Order
o Loyout
D A Text1 ]

4 )] Map Frame.
JEMsp

4[] Center_Point Site

p
/e Boundany

O

4 ffus senice 1

4 & ) 7
+ ) minute walking pedshed ] @ i
] ] |

+ )P minute walking pedshed 4

S ] A

i C)

+ 2 minute walking pecshed ] y

T /

! {
4ot 1 3 /

@ E i 8 ‘

)z Topograpric ]
e

2
e
£ 8

o~

N i
b

L

CH

W~

&)

05 013 0

Scale: 1:10,000043

By hiding and l:mhiding layers in your Contents (Drawing Order). You
can create maps with all three buffers showing or maps with just one

buffer.

The legend syncs with your contents (hidden layers will not show in

your legend)

Possible outcomes
for maps

& L]

%

a 8%

A

Walkable Catchment of 15 minutes at 158-182 Garnet Road

O iy oz o o
® 2




To export go
Share >
Export Layout

Select your
preferred file
type and folder
for saving

Also remember
click save on
the top left to
save your
ArcGIS Pro
project before
exiting.

Output

Layout X [E] ap2

T ) Ed = %
o O B PRI L | L PR i
Hel
1 &)
— \
’ O
! \
a8
~ 2
& >
\id ~
-~ < \
/ 2 v
c N &y >
7 @ 4
@ ! G 1
| ]
7
C) 7 bﬁ A
v @
)
\ )
& @) 9
4 . !
N -7
) ¢
® < (c ®
\ Q C)
’ v ;
\
8 g \
2 (AN A ®
5) 2 N
o O A X |
® 4y I
\
C) -
8 (R T
o 5

Walkable

15 minute walking pedshed

©) W <
Catchments at 158-182 Garnet Road

025 013 0 025 05

inute walking pedshed

Schools

inute walking pedshed

Scal: 1:10,000043

~ | Export Layout v

Layout

Properties Security Accessibility

<GIS\Projects\Wall

) Clip to graphics extent

ST
L

tmsge compression [Adepe ]
cunity

= — o

) Compressvector graphics

~ Resolution

Best Normal Fast
Ratio 1: [ 0| op1
~ Fonts

) Embed fonts
) Convert character marker symbols to polygon

~ PDF Settings

[ Export geor

~ Color Management
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